
CHÖÔNG XV. 
BIEÅU ÑOÀ VAØ ÑOÀ THÒ TRONG MapInfo

Ngoaøi khaû naêng trình baøy baûn ñoà, MapInfo coøn coù khaû naêng trình baøy bieåu ñoà vaø
ñoà thò töø caùc soá lieäu trong baûng döõ lieäu cuûa caùc baûng MapInfo. Khaû naêng laäp bieåu ñoà
vaø ñoà thò cuûa MapInfo veà nguyeân taéc cuõng gioáng nhö laäp bieåu ñoà trong phaàn meàm
Excel, tuy nhieân trong MapInfo coù raát nhieàu thieát laäp ñeå ta coù theå trình baøy moät bieåu
ñoà thaät ñeïp ñoàng thôøi coù theå ñieàu chænh taát caû caùc thaønh phaàn chính yeáu theo yù muoán.

XV.1. TOÅNG QUAÙT

XV.1.1. Phöông phaùp

Laäp bieåu ñoà töø döõ lieäu
trong baûng cuûa baûn ñoà soá
ñöôïc thöïc hieän baèng leänh
Window > New Gaph
Window hoaëc qua nuùt
leänh taét New Grapher treân
thanh coâng cuï Standard.
Bieåu ñoà ñöôïc laäp caên cöù
treân soá lieäu vì vaäy ta phaûi
coù tröôøng döõ lieäu kieåu soá
(numeric field) thì môùi coù
theå laäp bieåu ñoà ñöôïc.

Caùc böôùc ñeå laäp bieåu
ñoà nhö sau:

- Môû lôùp baûn ñoà coù chöùa
döõ lieäu ta muoán laäp
bieåu ñoà ra.

- Töø menu chính choïn
Window > New Graph
Window. Cöûa soå
Create Graph - Step 1
of 2 môû ra (hình XV.1).

- Beân traùi hoäp thoaïi laø oâ
Hình XV.1. Hoäp thoaïi Create Graph -

Step 1 of 2 - taïo Bieåu ñoà - böôùc 1.
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Graph vôùi moät hoäp lieät keâ danh saùch caùc kieåu bieåu ñoà cuûa MapInfo. Trong MapInfo
coù caùc kieåu bieåu ñoà sau: 3D (daïng khoâng gian 3 chieàu), Area (daïng dieän tích), Bar
(daïng hình que), Bubble (daïng bong boùng), Column (daïng coät), Histogram (bieåu ñoà
taàn soá), Line (daïng ñöôøng), Pie (daïng hình quaït), Scattered (daïng ñieåm phaân taùn),
Surface (daïng beà maët). Choïn kieåu bieåu ñoà ta muoán. Chi tieát hôn veà caùc kieåu bieåu
ñoà naøy ñöôïc trình baøy trong phaàn cuoái cuûa chöông naøy.

- Khi choïn xong kieåu bieåu ñoà thì beân phaûi trong phaàn Template seõ lieät keâ danh saùch
caùc maãu cuûa kieåu ñaõ ñöôïc choïn. Choïn maãu ta muoán roài choïn OK. Hoäp thoaïi Create
Graph - Step 2 of 2 môû ra (hình XV.2).

- OÂ Table cho pheùp ta choïn baûng ñeå taïo bieåu ñoà. Neáu ta ñaõ choïn moät soá vaät theå tröôùc
ñoù trong cöûa soå baûn ñoà hoaëc cöûa soå Browser thì phaàn Selection cuõng hieån thò cho
pheùp ta taïo bieåu ñoà cuûa phaàn ñaõ choïn maø thoâi. Choïn baûng hay phaàn döõ lieäu muoán
taïo bieåu ñoà.

- Trong phaàn Fields, coù hai oâ lôùn. OÂ Fields from Table lieät keâ danh saùch caùc tröôøng
kieåu soá coù trong baûng ñaõ choïn. OÂ Fields for Graph lieät keâ teân caùc tröôøng ñöôïc choïn
ñeå taïo bieåu ñoà. Choïn tröôøng caàn taïo bieåu ñoà trong oâ Fields from Table xong nhaán
nuùt Add ñeå theâm noù vaøo oâ Fields for Graph. Ta coù theå choïn nhieàu tröôøng neáu muoán
vaø moãi tröôøng ñöôïc goïi laø moät Series (Chuoãi). Khi ñaõ choïn caùc tröôøng vaøo oâ Fields
for Graph ñeå veõ bieåu ñoà nhöng ta laïi muoán loaïi chuùng ra thì coù theå choïn noù roài nhaán
nuùt Remove. Phaàn döôùi cuøng cuûa oâ Fields from Table laø hai tuyø choïn Join vaø

Hình XV.2. Hoäp thoaïi Create Graph - Step 2
of 2 - taïo Bieåu ñoà - böôùc 2.
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Expressions. Tuyø choïn Join cho pheùp ta taïo bieåu ñoà vôùi döõ lieäu töø moät baûng khaùc.
Tuyø choïn Expression cho pheùp ta taïo döõ lieäu baèng bieåu thöùc. Neáu choïn nhieàu
tröôøng thì ta coù theå di chuyeån vò trí tröôøng baèng caùch choïn tröôøng ñoù trong oâ Fields
for Graph roài nhaán nuùt Up hay Down. Thöù töï treân/döôùi cuûa caùc tröôøng trong oâ Fielsds
for Graph seõ quyeát ñònh thöù töï hieån thò cuûa bieåu ñoà sau naøy. Tröôøng naøo naèm treân
thì bieåu ñoà cuûa tröôøng ñoù seõ hieån thò phía tröôùc (hoaëc phía treân, tuyø kieåu bieåu ñoà).

- OÂ Label with Column cho pheùp choïn tröôøng ñeå daùn nhaõn bieåu ñoà. Nuùt muõi teân thaû
xuoáng duøng ñeå môû danh saùch caùc tröôøng coù trong baûng ñeå choïn tröôøng daùn nhaõn
cho bieåu ñoà. Ta cuõng coù theå choïn None neáu khoâng muoán daùn nhaõn.

- Phía döôùi oâ Label with Column coù hai tuyø choïn: Series in Rows vaø Series in Columns.
Neáu döõ lieäu xeáp theo haøng thì ta choïn tuyø choïn ñaàu, neáu döõ lieäu saép theo coät thì ta
choïn tuyø choïn thöù hai. Ña phaàn laø döõ lieäu ñöôïc saép theo haøng neân tuøy choïn maëc
ñònh laø Series in Rows.

- Sau khi choïn xong nhaán chuoät vaøo nuùt OK. Bieåu ñoà seõ ñöôïc trình baøy trong moät cöûa
soå coù tieâu ñeà daïng <teân baûng> Graph. Neáu ta veõ bieåu ñoà töø moät pheùp choïn thì tieâu
ñeà bieåu ñoà coù daïng <queryn> Graph, trong ñoù n laø soá thöù töï cuûa pheùp choïn tính töø
luùc khôûi ñoäng MapInfo (hình XV.3), tröø khi ta ñaët teân cho pheùp choïn thì bieåu ñoà seõ
coù daïng <teân pheùp choïn> Graph.

XV.1.2. Ñieàu chænh bieåu ñoà

Phaàn naøy chæ trình baøy chi tieát caùch ñieàu chænh loaïi bieåu ñoà thöôøng ñöôïc söû duïng
nhaát laø bieåu ñoà coät. Ñoái vôùi caùc loaïi bieåu ñoà khaùc, noäi dung ñieàu chænh seõ khaùc nhau.
Tuy nhieân caùch ñieàu chænh caùc thaønh phaàn chính yeáu cuûa bieåu ñoà nhö Tieâu ñeà chính,
tieâu ñeà phuï, truïc tung, truïc hoaønh, teân nhoùm, ghi chuù,... veà cô baûn laø gioáng nhau.

Bieåu ñoà sau khi veõ xong
coù caùc phaàn sau:

- Treân cuøng laø phaàn coù daïng
Graph of: <teân baûng/teân
pheùp choïn>, ngay phía
döôùi laø haøng <subtitle>.

- Beân traùi cöûa soå laø phaàn
bieåu ñoà goàm coù: teân truïc
trung coù daïng <Y1 axis
title>, teân truïc hoaønh coù
daïng <teân tröôøng ñöôïc daùn
nhaõn>.

- Beân phaûi bieåu ñoà laø chuù
giaûi.

- Döôùi cuøng laø caùc noäi dung
<group title> (teân nhoùm) vaø
<footnote> (ghi chuù).

Khi cöûa soå bieåu ñoà ñöôïc
kích hoaït thì treân menu chính
coù theâm moät menu con nöõa laø Hình XV.3. Bieåu ñoà daïng Bong boùng (Bubble).

PDF created with pdfFactory Pro trial version www.pdffactory.com

http://www.pdffactory.com


Graph. Menu naøy cho pheùp ta ñieàu chænh caùc thaønh phaàn
cuûa bieåu ñoà (hình XV.4). Phaàn döôùi ñaây seõ trình baøy yù
nghóa caùc leänh cuûa menu naøy.

XV.1.2.1. Leänh Formatting

Ñaây laø leänh ñònh daïng caùc thaønh phaàn cuûa bieåu ñoà.
Muoán ñònh daïng phaàn naøo cuûa bieåu ñoà thì ta phaûi nhaép
chuoät leân phaàn ñoù tröôùc roài töø menu chính choïn Graph >
Formatting thì menu ñònh daïng töông öùng cuûa phaàn ñöôïc
choïn seõ môû ra. Neáu ta khoâng choïn phaàn naøo trong cöûa soå
bieåu ñoà maø vaøo leänh Formatting thì hoäp thoaïi hieän ra laø
hoäp thoaïi Formatting toång quaùt cho pheùp ta chænh kieåu neàn
cuûa cöûa soå bieåu ñoà.

XV.1.2.2. Leänh General Options

Leänh naøy cho pheùp ñieàu chænh caùc tuyø choïn cuûa bieåu ñoà. Khi choïn leänh naøy moät
hoäp thoaïi coù nhieàu muïc môû ra (hình XV.5). Ta vaøo töøng muïc baèng caùch nhaép chuoät
vaøo thanh tieâu ñeà cuûa töøng muïc ôû treân.

- General: beân traùi hoäp thoaïi naøy hieån thò daïng cuûa cöûa soå bieåu ñoà. Noäi dung muïc
naøy coù caùc thaønh phaàn sau: 

+ Overlap: Thanh tröôït naøy ñeå ñieàu chænh khoaûng caùch giöõa caùc yeáu toá thaønh phaàn
cuûa moät chuoãi döõ lieäu. Khi ta ñieàu chænh thanh tröôït naøy thì caùc coät cuûa bieåu ñoà
seõ caùch xa hay xích laïi gaàn nhau. Giaù trò toái thieåu laø -100 (aâm 100), luùc ñoù caùc
coät trong moät nhoùm seõ choàng leân nhau; giaù trò toái ña laø 100 (döông 100) luùc ñoù
caùc coät trong bieåu ñoà seõ caùch xa nhau toái ña nhöng khoâng choàng leân coät cuûa
moät nhoùm khaùc (trong tröôøng hôïp ta choïn veõ bieåu ñoà töø nhieàu tröôøng). Khi ta
ñieàu chænh thanh tröôït naøy thì bieåu ñoà maãu beân traùi seõ thay ñoåi töông öùng.

+ Gap Width: Thanh tröôït naøy ñeå ñieàu chænh khoaûng caùch giöõa caùc nhoùm döõ lieäu
khaùc nhau khi veõ bieåu ñoà töø nhieàu tröôøng. Giaù trò naøy thay ñoåi trong khoaûng töø
0 ñeán 99. Neáu giaù trò baèng 0 thì caùc nhoùm/chuoãi döõ lieäu seõ naèm saùt nhau, neáu
baèng 99 thì chuùng caùch xa nhau toái ña. Riser Shape cho pheùp ta thay ñoåi hình
daïng cuûa caùc coät bieåu ñoà. Trong bieåu ñoà coät coù 3 tuyø choïn laø Rectangle (hình
chöõ nhaät), Beveled Box (ñoå boùng xuoâi) vaø Reverse Beveled Box (ñoå boùng
ngöôïc).

+ Use Depth (taïo bieåu ñoà daïng khoái 3 chieàu): Neáu ta ñaùnh daáu choïn vaøo phaàn naøy
thì phaàn Riser Shape seõ bò môø ñi vì taùc duïng chænh daïng bieåu ñoà seõ thuoäc phaàn
naøy. Phaàn naøy coù hai tuyø choïn laø Depth cho pheùp ta chænh chieàu saâu cuûa coät
bieåu ñoà vaø Direction cho pheùp chænh goùc nhìn cuûa bieåu ñoà 3 chieàu.

- Layout: phaàn naøy duøng ñeå ñieàu chænh caùch saép xeáp caùc döõ lieäu thaønh phaàn trong
moät nhoùm/chuoãi döõ lieäu. Phaàn Type cho pheùp choïn caùc kieåu Clustered, Stacked,
Percent vaø True 3D Column. Choïn kieåu ta muoán trình baøy bieåu ñoà vaø xem söï thay
ñoåi cuûa bieåu ñoà maãu beân traùi ñeå quyeát ñònh choïn kieåu naøo öng yù. Tuyø choïn Dual
Axes cho pheùp bieåu dieãn döõ lieäu theo hai truïc tung treân bieåu ñoà, moät soá baûn ghi
theo moät truïc tung vaø moät soá baûn ghi khaùc theo truïc tung thöù hai. Neáu ñaùnh daáu
tuyø choïn naøy thì ta coù theâm moät tuyø choïn nöõa phía döôùi laø Split Dual Axes. Tuyø choïn

Hình XV.4. Menu Graph.
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naøy cho pheùp taùch döõ lieäu ra laøm hai nhoùm vaø bieåu dieãn treân hai ñoà thò naèm caïnh
nhau. Xem söï thay ñoåi töông öùng cuûa bieåu ñoà maãu beân traùi ñeå choïn. Tuyø choïn naøy
seõ laøm cho muïc Dual Y Options noåi roõ leân (xem tieáp phaàn döôùi).

- Data Labels: Cho pheùp daùn nhaõn döõ lieäu leân bieåu ñoà. Maëc ñònh tuyø choïn naøy taét ñi.
Neáu ñaùnh daáu choïn vaøo oâ Show Data labels thì caùc tuyø choïn Labels Location vaø
Label Format baät leân. Labels Location cho pheùp chænh vò trí cuûa giaù trò döõ lieäu, coù 4
tuyø choïn laø Outside Maximum (giaù trò döõ lieäu naèm treân ñaàu vaø ngoaøi töøng coät bieåu
ñoà), Inside Maximum (naèm trong bieåu ñoà vaø ôû treân cuøng), Center (naèm ngay giöõa
bieåu ñoà) vaø Base of Chart (naèm ngay döôùi ñaùy bieåu ñoà). Xem söï thay ñoåi töông öùng
ôû bieåu ñoà maãu beân traùi khi choïn caùc kieåu khaùc nhau. Label Format cho pheùp choïn
caùch daùn thoâng tin leân bieåu ñoà. Coù 3 tuyø choïn laø Value (daùn nhaõn laø giaù trò döõ lieäu),
Label (daùn nhaõn laø teân tröôøng ñöôïc choïn daùn nhaõn) vaø Value & Lables (daùn caû hai
thoâng tin treân). Neáu daùn nhaõn laø giaù trò döõ lieäu leân bieåu ñoà thì phaàn Number seõ noåi
roõ leân cho pheùp ñònh daïng kieåu döõ lieäu.

- Numbers: cho pheùp choïn caùc kieåu ñònh daïng döõ lieäu khaùc nhau. Khi choïn muïc naøy
ta coù oâ Category cho pheùp choïn hieån thò caùc ñònh daïng khaùc nhau cuûa döõ lieäu. Caùc
kieåu döõ lieäu cho pheùp bao goàm General (kieåu toång quaùt, khoâng ñònh daïng), Number
(kieåu soá), Currency (kieåu tieàn teä), Date (kieåu ngaøy thaùng), Time (kieåu thôøi gian),
Percent (kieåu tyû leä phaàn traêm), Fraction (kieåu phaân soá), Scientific (kieåu soá khoa hoïc,
soá muõ cuûa logarit Neper), Special (kieåu ñaëc bieät). Moãi tuyø choïn naøy khi ñöôïc choïn
laïi coù moät soá tuyø choïn khaùc chi tieát hôn cho töøng loaïi.

- Dual Y Options: Chæ hieän leân khi ta choïn tuyø choïn Dual Axes trong muïc Layout.
Phaàn naøy cho pheùp ta choïn nhöõng baûn ghi naøo hieån thò treân truïc tung sô caáp

Hình XV.5. Hoäp thoaïi General Options ñeå chænh söûa thuoäc tính bieåu ñoà.
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(Primary Y1 Axis) vaø nhöõng  baûn
ghi naøo hieån thò treân truïc tung
thöù caáp (Secondary Y2 Axis).
Giöõa hai coät naøy coät moät nuùt cho
pheùp ta choïn baûn ghi vaø chuyeån
chuùng qua laïi giöõa hai coät.

- Look: bao goàm hai phaàn chính laø
Color Mode vaø tuyø choïn Show Legend.
Phaàn Color Mode duøng ñeå choïn kieåu toâ
maøu bieåu ñoà. Coù hai tuyø choïn laø Color by
Series (toâ maøu bieåu ñoà khaùc nhau cho töøng giaù trò caù theå trong nhoùm/chuoãi döõ lieäu)
vaø Color by Category (toâ maøu bieåu ñoà theo nhoùm/chuoãi döõ lieäu, neáu choïn muïc naøy
caùc giaù trò döõ lieäu caù theå trong töøng nhoùm seõ coù cuøng maøu). Tuyø choïn Show Legend
cho pheùp baät/taét phaàn chuù giaûi cuûa bieåu ñoà. Phaàn Markers and Text cho pheùp chænh
vò trí cuûa noäi dung chuù giaûi vaø chuù giaûi. Choïn töøng kieåu vaø xem söï thay ñoåi töông
öùng cuûa bieåu ñoà maãu beân traùi. Phaàn Layout cho pheùp chænh vò trí cuûa chuù giaûi so
vôùi vò trí bieåu ñoà. Phaàn Box Style cho pheùp chænh ñöôøng vieàn cuûa chuù giaûi, bao goàm
caùc tuyø choïn No Frame, Single Line Frame, Double Line Frame, Beveled Frame
(khung ñoå boùng xuoâi) vaø Reverse Beveled Frame (khung ñoå boùng ngöôïc).

- Display Status: baät/taét caùc yeáu toá chính cuûa bieåu ñoà. Phaàn Axes coù hai tuyø choïn laø
Category Axis (baät taét teân truïc hoaønh) vaø Value Axis (baät/taét teân truïc tung). Phaàn
Major Grid vaø Minor Grid cho pheùp baät/taét caùc ñöôøng löôùi chính vaø phuï theo chieàu
truïc hoaønh vaø truïc tung töông öùng beân traùi. Hai tuyø choïn döôùi cuøng laø Legend vaø
Data Labels cho pheùp baät/taét chuù giaûi vaø nhaõn.

XV.1.2.3. Leänh Series Optioins

Series Options cho pheùp ñieàu chænh moät thaønh phaàn rieâng leû cuûa bieåu ñoà (töùc moät
baûn ghi trong baûng döõ lieäu). Ñeå ñieàu chænh, duøng coâng cuï choïn nhaép chuoät choïn

thaønh phaàn ñoù treân bieåu ñoà hay treân chuù giaûi roài choïn Graph > Series Options. Hoäp

thoaïi Series Options môû ra cho pheùp ta ñieàu chænh hình daïng cuõng nhö caùc thieát laäp

veà nhaõn cuûa phaàn ñöôïc choïn.

XV.1.2.4. Grid and Scales

Leänh naøy cho pheùp ñieàu chænh caùc ñöôøng löôùi ñònh vò cuõng nhö hình daïng cuûa bieåu
ñoà. Hoäp thoaïi naøy coù caùc menu con theo hai chieàu. Chieàu ñöùng beân traùi ta coù Y1 Axis
vaø Category Axis. Khi choïn moät trong hai menu naøy thì caùc noäi dung ôû caùc muïc treân
haøng ngang thay ñoåi töông öùng. Neáu choïn Y1 Axis (truïc tung Y1) thì menu ngang coù
caùc noäi dung General, Scales, Labels, Numbers, Grids. Neáu choïn Category Axis (truïc
hoaønh) thì menu ngang coù caùc muïc General, Labels, Grids.

- Y1 Axis: goàm caùc noäi dung sau:
+ General: Cho pheùp chænh vò trí truïc tung. Noù bao goàm caùc tuyø choïn Axis on Left

(Veõ truïc tung beân traùi bieåu ñoà), Axis on Right (veõ truïc tung beân phaûi), Axis on
Both Sides (veõ truïc tung caû hai beân), vaø Make this a Descending Axis (ñaùnh daáu
tuyø choïn naøy seõ cho pheùp veõ bieåu ñoà theo chieàu ngöôïc töø treân xuoáng - töùc truïc
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tung naèm treân ñaàu coät bieåu ñoà). 
+ Scale: Cho pheùp ñieàu chænh caùc tyû leä hieån thò thoâng tin treân truïc tung. Noù bao

goàm caùc tuyø choïn Use Logarithmic Scale on this Axis (Chaám khoaûng caùch giaù trò
treân truïc tung theo tyû leä logarit), Always Include Zero in This Scale (truïc tung luoân
coù giaù trò zero ôû goác ñoà thò), Use Manual Settings for Maximum Value (ñieàu chænh
thieát laäp theo giaù trò toái ña) vaø Use Manual Settings for Minimum Value (ñieàu
chænh thieát laäp theo giaù trò toái thieåu - töùc goác ñoà thò laø giaù trò nhoû nhaát).

+ Labels: Coù moät tuyø choïn laø Show Labels for this Axis, ñaùnh daáu choïn vaøo muïc
naøy seõ hieån thò nhaõn cuûa truïc naøy treân bieåu ñoà. Neáu ñaùnh daáu choïn vaøo muïc

naøy thì seõ coù hai tuyø choïn nöõa laø Don’t Show Maximum Value Label (khoâng hieån
thò nhaõn coù giaù trò lôùn nhaát) vaø Don’t Show Minimum Value Label (khoâng hieån thò
nhaõn coù giaù trò nhoû nhaát).

+ Number: Cho pheùp choïn ñònh daïng kieåu soá, töông töï nhö trong muïc Number cuûa
phaàn General Options.

+ Grid: Cho pheùp chænh caùc ñöôøng löôùi ñònh vò cuûa bieåu ñoà. Trong muïc naøy coù hai
phaàn laø Major Gridlines (Ñöôøng löôùi chính) vaø Minor Gridlines (Ñöôøng löôùi phuï).
Noäi dung cuûa hai hoäp thoaïi naøy gioáng nhau, bao goàm hai tuyø choïn chính laø Show
Gridlines vaø Use Manual Grids, döôùi cuøng laø tuyø choïn Draw Custom Line At.

* Show Gridlines: Neáu ñaùnh daáu choïn phaàn naøy thì beân döôùi noåi leân oâ Grid
Style. OÂ naøy cho pheùp choïn ñònh daïng kieåu ñöôøng chia löôùi, goàm caùc tuyø
choïn Regular Grids, Grids and Ticks, Inner Ticks, Outer Ticks vaø Spanning
Ticks.

* Use Manual Grids: neáu ñaùnh daáu thì oâ Interval Value phía döôùi noåi leân cho

Hình XV.6. Hoäp thoaïi Numeric Axis Grids & Scales ñeå ñieàu chænh
caùc truïc ñoà thò cuõng nhö löôùi treân bieåu ñoà.
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pheùp choïn khoaûng giaù trò giöõa caùc ñöôøng löôùi.
* Draw Custom LIne At: neáu ñaùnh daáu thì ta coù theå veõ moät ñöôøng chaïy song

song vôùi truïc hoaønh vaø caùch truïc hoaønh moät khoaûng giaù trò do ta naïp vaøo oâ
giaù trò beân phaûi tuyø choïn naøy.

- Category Axis: coù 3 phaàn
+ General: Cho pheùp chænh vò trí truïc hoaønh, goàm 3 tuyø choïn laø Axis on Bottom (veõ

truïc hoaønh döôùi ñaùy), Axis on Top (veõ truïc hoaønh phía treân) vaø Axis on Both
Sides (veõ truïc hoaønh caû treân laãn döôùi). Döôùi cuøng laø tuyø choïn Draw Categories
in Reverse Order. Ñaùnh daáu choïn vaøo tuyø choïn naøy seõ khieán cho bieåu ñoà ñöôïc
veõ vôùi thöù töï caùc nhoùm/chuoãi döõ lieäu ngöôïc laïi. Tuyø choïn naøy khoâng coù taùc duïng
neáu ta chæ choïn veõ moät nhoùm döõ lieäu treân bieåu ñoà.

+ Labels: Cho pheùp ta ñieàu chænh vieäc baät/taét teân cuûa truïc hoaønh (laø teân tröôøng
ñöôïc ñöôïc söû duïng ñeå veõ bieåu ñoà). Neáu ñaùnh daáu choïn vaøo tuyø choïn Show
Labels for this Axis thì coù hai tuyø choïn nöõa phía döôùi laø Stagger Labels (Nhaõn coù
ñöôøng chæ) vaø Use manual Numbers of Categories.

+ Grids: Coù caùc tuyø choïn töông töï nhö trong muïc Grids cuûa phaàn truïc tung.

XV.1.2.5. Leänh Titles
Phaàn naøy cho pheùp ta chænh noäi dung caùc tieâu ñeà trong cöûa soå bieåu ñoà. Noù bao

goàm caùc tuyø choïn sau:

- Title: ñaùnh daáu choïn vaøo oâ naøy seõ môû teân chính cuûa bieåu ñoà leân. OÂ beân traùi duøng
ñeå goõ laïi teân bieåu ñoà.

- Subtitle: baät/taét vaø chænh noäi dung cuûa tieâu ñeà phuï.

- Footnote: baät/taét chaân ñeà vaø goõ noäi dung cuûa noù.

- Category Title: baät/taét vaø goõ noäi dung cuûa nhoùm döõ lieäu.

- Value Title (Y1): baät/taét vaø söûa teân cuûa truïc tung (truïc giaù trò).

XV.1.2.6. Leänh 3D View Angle
Leänh naøy chæ hieän leân neáu trong phaàn Graph > General Options > Layout ta choïn

True 3D Column. Phaàn 3D View Angle naøy cho pheùp ta chænh chieàu saâu vaø goùc nhìn
cuûa bieåu ñoà kieåu 3 chieàu. Choïn leänh naøy seõ môû ra hoäp thoaïi Choose a viewing Angle,
cho pheùp ta choïn 10 goùc nhìn khaùc nhau cuûa bieåu ñoà 3D theo maãu. Phía treân coøn coù
nuùt Advanced Options duøng ñeå chænh goùc nhìn cuûa bieåu ñoà chi tieát hôn nöõa.

XV.1.2.7. Leänh Save As Template

Leänh cuoái cuøng trong menu Graph laø Save As Template. Leänh naøy cho pheùp ta löu
laïi caùc thieát laäp cuûa bieåu ñoà maø ta ñaõ ñieàu chænh. Neáu löu laïi thì laàn sau khi ta taïo moät
bieåu ñoà môùi caùc thieát laäp cuûa ta seõ hieän leân trong phaàn choïn bieåu ñoà vaø kieåu bieåu ñoà
ñeå ta coù theå söû duïng ngay. Khi thöïc hieän leänh löu maãu bieåu ñoà töï laøm, MapInfo seõ taïo
ra moät taäp tin löu caùc ñònh daïng bieåu ñoà maø ta ñaõ ñieàu chænh. Taäp tin naøy  coù ñuoâi môû
roäng laø .3tf. Taäp tin naøy ñöôïc löu trong thö muïc MapInfo\Professional\Graph
Support\Templates. Trong thö muïc Templates naøy coù caùc thö muïc con töông öùng vôùi
10 loaïi bieåu ñoà. Maãu bieåu ñoà ta taïo ra thuoäc loaïi naøo thì MapInfo seõ töï ñoäng löu taäp tin
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.3tf vaøo thö muïc ñoù. Laàn sau khi muoán söû duïng ta chæ
caàn choïn maãu ñaõ taïo ra vaø laäp bieåu ñoà, khoâng caàn phaûi
ñieàu chænh caùc chi tieát cuûa bieåu ñoà laïi nöõa.

Ngoaøi caùch ñieàu chænh bieåu ñoà theo caùc leänh töø menu
Graph neâu treân, ta coù theå ñieàu chænh nhanh ñònh daïng
töøng thaønh phaàn cuûa bieåu ñoà baèng caùch duøng coâng cuï
choïn nhaép chuoät ñuùp leân moät thaønh phaàn naøo ñoù vaø
vaøo ngay hoäp thoaïi Formatting ñeå ñieàu chænh ñònh daïng
cuûa thaønh phaàn ñoù.

XV.1.3. Pheùp choïn treân cöûa soå bieåu ñoà vaø baûng töông
öùng cuûa noù

Trong moät baûng döõ lieäu ñaõ ñöôïc veõ bieåu ñoà thì baát kyø pheùp
choïn naøo treân baûng döõ lieäu baèng coâng cuï choïn cuõng seõ ñöôïc phaûn

aùnh töông öùng treân cöûa soå bieåu ñoà neáu vaät theå ñöôïc choïn coù döõ lieäu ñöôïc trình baøy
treân bieåu ñoà ñoù. Coù nghóa laø neáu ta choïn moät baûn ghi (haøng) treân cöûa soå Browser hay
vaät theå treân cöûa soå baûn ñoà thì coät bieåu ñoà (trong tröôøng hôïp laø bieåu ñoà coät) töông öùng
treân cöûa soå Bieåu ñoà cuõng ñöôïc choïn.

Khi kích hoaït cöûa soå bieåu ñoà thì nuùt Graph Select treân thanh coâng cuï Main seõ
noåi leân vaø söû duïng ñöôïc. Neáu ta söû duïng nuùt coâng cuï choïn bieåu ñoà ñeå choïn moät hay
nhieàu vaät theå treân cöûa soå Bieåu ñoà thì pheùp choïn ñoù seõ thay theá pheùp choïn tröôùc ñoù
treân baûng döõ lieäu hay cöûa soå baûn ñoà töông öùng. Pheùp choïn moät vaät theå treân cöûa soå
bieåu ñoà (töùc coät bieåu ñoà, trong tröôøng hôïp laø bieåu ñoà coät) seõ ñöôïc phaûn aùnh qua vieäc
moät haøng treân baûng döõ lieäu hay moät vaät theå treân cöûa soå baûn ñoà ñöôïc choïn töông öùng.
Neáu ta choïn moät vaät theå treân cöûa soå baûn ñoà maø khoâng lieân quan ñeán moät haøng naøo ñoù
treân baûng töông öùng (ví duï nhö choïn tieâu ñeà cuûa bieåu ñoà chaúng haïn, vaät theå naøy treân
cöûa soå bieåu ñoà khoâng lieân quan gì ñeán döõ lieäu caû) thì pheùp choïn tröôùc ñoù treân cöûa soå
bieåu ñoà seõ bò khöû. Gioáng nhö caùc cöûa soå khaùc trong MapInfo ta coù theå choïn nhieàu vaät
theå treân cöûa soå bieåu ñoà baèng caùch söû duïng phím <Shift>.

Löu yù raèng vieäc choïn caùc vaät theå treân cöûa soå bieåu ñoà baèng nuùt coâng cuï Graph
Select khoâng gioáng nhö choïn caùc vaät theå treân cöûa soå bieåu ñoà baèng coâng cuï choïn thoâng
thöôøng . Choïn caùc vaät theå treân cöûa soå bieåu ñoà baèng coâng cuï choïn bình thöôøng laø
ñeå chænh söûa vaät theå ñoù. Neáu muoán choïn caùc vaät theå treân cöûa soå bieåu ñoà nhaèm muïc
ñích thay theá pheùp choïn tröôùc ñoù treân baûng döõ lieäu töông öùng thì ta phaûi söû duïng coâng
cuï choïn Graph Select.

Ñoái vôùi moät soá kieåu bieåu ñoà khoâng coù söï lieân quan gì giöõa vaät theå treân cöûa soå bieåu
ñoà vaø döõ lieäu trong baûng, ví duï nhö bieåu ñoà Taàn soá (Histogram). Trong tröôøng hôïp ñoù
nuùt choïn bieåu ñoà Graph Select khoâng söû duïng ñöôïc. Pheùp choïn treân cöûa soå bieåu ñoà
luùc ñoù seõ khoâng choïn moät vaät theå ñoà hoaï hay baûn ghi naøo cuûa baûng töông öùng.

XV.1.4. Löu bieåu ñoà

Bieåu ñoà ñöôïc löu laïi baèng leänh löu workspace (töø menu chính choïn File > Save
Workspace). Trong tröôøng hôïp coù nhieàu cöûa soå bieåu ñoà ñöôïc taïo ra vaø ta duøng leänh
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Save Workspace thì MapInfo seõ löu moãi cöûa soå bieåu ñoà döôùi moät teân rieâng coù ñuoâi môû
roäng laø .3tf trong cuøng thö muïc vôùi teân taäp tin workspace ñöôïc löu. Teân cuûa taäp tin
workspace seõ coù daïng <teân workspace>, <teân bieåu ñoà>.3tf; trong ñoù <teân workspace>
laø teân taäp tin phieân laøm vieäc maø ta ñang muoán löu vaø <teân bieåu ñoà> laø teân cuûa cöûa soå
bieåu ñoà ñaõ ñöôïc taïo ra.

XV.2. VÍ DUÏ

Ta seõ xem xeùt moät soá ví duï taïo bieåu ñoà döôùi ñaây.

XV.2.1. Ví duï Bieåu ñoà coät

Trong ví duï naøy ta seõ laäp bieåu ñoà coät theo daân soá cuûa 10 tænh phía Nam. Caùch laøm
nhö sau:

1 -   Môû baûng cac_tinh ra.

2 -   Duøng coâng cuï choïn ñeå choïn 10 tænh ôû phía Nam cuûa Vieät Nam (An Giang, Baïc
Lieâu, Beán Tre, Caàn Thô, Caø Mau, Kieân Giang, Ñoàng Thaùp, Soùc Traêng, Traø Vinh,
Vónh Long).

3 -   Töø menu chính choïn Query > Select, trong hoäp thoaïi Select ôû muïc Select records
from Table choïn Selection, trong oâ Store Results in Table ta goõ
“_10_tinh_phia_Nam” (MapInfo khoâng cho pheùp ñaët teân Query coù soá ñöùng ñaàu
neân ta phaûi cho theâm moät gaïch döôùi phía tröôùc), trong oâ Sort Results by Column

Hình XV.7. Hoäp thoaïi taïo bieåu ñoà - böôùc 2 cho daân soá 10 tænh.
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choïn tröôøng dan_so ñeå saép thöù töï theo soá daân töø nhoû ñeán lôùn, baät daáu choïn trong
oâ Browse Results leân, xong choïn OK ñeå môû baûng döõ lieäu cuûa 10 tænh vöøa choïn
ra. Chænh kieåu chöõ laïi cho ñuùng tieáng Vieät neáu muoán. Ta thaáy cöûa soå döõ lieäu
Browser môû ra coù teân laø _10_tinh_phia_Nam Browser.

4 -   Choïn Window > New Graph Window hay choïn nhanh baèng caùch nhaép chuoät vaøo

nuùt New Grapher treân thanh coâng cuï Standard. Hoäp thoaïi Create Graph -
Step 1 of 2 môû ra.

5 -   Trong phaàn Graph choïn kieåu Column; trong phaàn Template choïn Clustered, xong
choïn Next. Hoäp thoaïi Create Graph - Step 2 of 2 môû ra (hình XV.7).

6 -   Trong oâ Table choïn _10_tinh_phia_Nam, trong oâ Fields from table choïn tröôøng
dan_so roài nhaán nuùt Add ñeå theâm noù vaøo oâ Fields for Graph, trong oâ Label with
Column choïn tröôøng ten ñeå daùn nhaõn bieåu ñoà baèng tröôøng naøy. Kieåm tra xem tuyø
choïn Series in Rows ñaõ ñöôïc choïn ñuùng chöa.

7 -   Xong choïn OK.

Bieåu ñoà daân soá cuûa 10 tænh phía Nam ñöôïc taïo xong (hình XV.8). Ta seõ tieán haønh
ñieàu chænh ñeå cho bieåu ñoà ñuùng theo yù muoán.

8 -   Kích hoaït cöûa soå bieåu ñoà môùi taïo thaønh baèng caùch nhaép chuoät vaøo thanh tieâu ñeà.

9 -  Töø menu chính choïn Graph > General Options. Hoäp thoaïi General Options môû ra.

10 - Nhaép chuoät choïn General ñeå môû hoäp thoaïi naøy ra vaø taét choïn trong oâ Use Depth
ñi (khoâng laøm bieåu ñoà coät 3 chieàu). Khoâng ñieàu chænh gì trong phaàn Layout.

11 - Nhaép chuoät choïn Data Labels ñeå môû hoäp thoaïi naøy ra. Ñaùnh daáu choïn vaøo oâ

Hình XV.8. Bieåu ñoà daân soá 10 tænh khi vöøa taïo xong.
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Show Data labels. Trong oâ Label Location choïn Outside Maximum ñeå daùn nhaõn
leân ñaàu coät bieåu ñoà, trong oâ Label Format choïn Value ñeå daùn nhaõn laø giaù trò trong
tröôøng ten (töùc soá daân).

12 - Nhaép chuoät vaøo Numbers ñeå môû menu naøy ra. Trong oâ Category choïn Number
(ñònh daïng soá lieäu theo kieåu soá), trong oâ Decimal goõ vaøo soá hai (laáy hai soá leû sau
daáu thaäp phaân), ñaùnh daáu choïn vaøo oâ Use thousands Seperator (,) (hieån thò daáu
phaân caùch haøng nghìn, laø daáu phaåy trong heä ño löôøng Anh-Myõ). Khoâng chænh söûa
gì trong phaàn Look ( ta seõ chænh söûa phaàn Display Status sau).

13 - Choïn OK.

Daân soá cuûa töøng tænh ñaõ ñöôïc hieån thò treân ñaàu töøng coät bieåu ñoà (hình XV.9).

13 - Töø menu chính choïn Graph > Titles. Hoäp thoaïi Titles môû ra.

14 - Trong oâ Title, ta goõ: “Bieåu Ñoà Daân soá 10 tænh phía Nam”, trong oâ Subtitle
ta goõ “(Soá lieäu naêm 1999)”, trong oâ Value Title (Y1) ta goõ: “Soá daân
(nghìn ngöôøi)”. Löu yù laø tieáng Vieät hieån thò khoâng ñuùng vì theá phaûi goõ caån
thaän (hình XV.10). Taét choïn trong caùc oâ Footnote vaø Category Title ñi vì khoâng
caàn thieát. Xong choïn OK. Ñoà thò ñaõ ñöôïc ñieàu chænh phaàn tieâu ñeà cho ñuùng,
nhöng tieáng Vieät chöa hieån thò ñuùng.

15 - Söû duïng coâng cuï choïn treân thanh coâng cuï Main ñeå nhaép chuoät vaøo haøng tieâu ñeà
cuûa bieåu ñoà. Moät ñöôøng vieàn maøu ñen hieän leân xung quanh. Töø menu chính choïn
Graph > Formatting. Hoäp thoaïi Formatting môû ra. Trong caùc noäi dung cuûa hoäp
thoaïi naøy, chæ coù muïc Font laø hieän roõ vì vaät theå ta choïn tröôùc ñoù laø chöõ. Chænh
kieåu chöõ cuûa tieâu ñeà theo yù muoán. Choïn kieåu chöõ laø tieáng Vieät. Laøm xong choïn
OK. Ta thaáy tieáng Vieät hieän leân ñuùng. Thöïc hieän töông töï cho caùc noäi dung chöõ
khaùc cuûa bieåu ñoà ñeå chænh veà tieáng Vieät cho ñuùng. Nhôù chænh côõ chöõ cho phuø

Hình XV.9. Hieån thò soá lieäu treân ñaàu töøng coät bieåu ñoà.
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hôïp (tieâu ñeà phaûi chöõ lôùn nhaát, caùc côõ chöõ khaùc nhoû hôn,...).

16 - Neáu tieâu ñeà cuûa truïc tung (Soá daân (nghìn ngöôøi)) khuaát trong phaàn soá lieäu
ta coù theå duøng coâng cuï choïn ñeå nhaép chuoät leân noù cho hieän phaàn ñöôøng vieàn ra
roài giöõ phím chuoät traùi treân ñoù vaø reâ chuoät ñeå di chuyeån ñeán vò trí thích hôïp.

17 - Nhaép chuoät leân moät giaù trò döõ lieäu hieän treân ñaàu moãi coät bieåu ñoà. Ta thaáy raèng taát
caû caùc soá lieäu khaùc cuõng ñöôïc choïn. Choïn Graph > Formatting ñeå chænh côõ chöõ
cho phuø hôïp neáu thaáy caàn thieát. Laøm töông töï cho thöôùc soá lieäu beân traùi truïc tung
ñeå chænh côõ chöõ cho phuø hôïp. Nhaép chuoät leân moät teân tænh trong oâ chuù giaûi, töông
töï taát caû caùc tænh khaùc cuõng ñöôïc choïn. Chænh kieåu chöõ veà tieáng Vieät cho ñuùng
cuõng baèng leänh Graph > Formatting.

18 - Ta cuõng coù theå ñoåi maøu cuûa töøng coät bieåu ñoà baèng caùch söû duïng coâng cuï choïn
ñeå nhaép chuoät leân töøng coät roài choïn Graph > Formatting ñeå chænh maøu cuûa töøng
coät neáu muoán.

19- Ta thaáy raèng caùc ñöôøng löôùi chaïy ngang treân ñoà thò coù theå khoâng ñeïp vaø khoâng
caàn thieát vì ta ñaõ hieån thò soá lieäu treân ñaàu moãi coät bieåu ñoà. Neáu muoán boû caùc
ñöôøng naøy ñi thì ta kích hoaït cöûa soå bieåu ñoà roài töø  menu chính choïn Graph >
Grids & Scales. Treân menu Grids cuûa phaàn Y1 Axis (chieàu ñöùng), taét choïn trong
oâ Show Gridlines ñi.

20- Neáu khoâng muoán hieän ñöôøng ranh giôùi bao quanh bieåu ñoà, nhaép chuoät choïn phaàn
khu bieåu ñoà ñeå hieån thò caùc ñieåm khoáng cheá ranh giôùi bieåu ñoà leân roài choïn Graph
> Formatting. Trong hoäp thoaïi naøy phaàn Font bò môø ñi, choïn Line roài nhaép chuoät
vaøo nuùt Tranparent ôû treân baûng maøu ñeå taét ñöôøng vieàn ñi. Ta coù theå xem thöû baèng
caùch nhaép chuoät vaøo nuùt Apply, neáu thaáy öng yù thì choïn OK.

21- Phía döôùi truïc hoaønh (töùc Category Axis) laø teân tröôøng ñöôïc laáy soá lieäu ñeå veõ bieåu
ñoà. Teân tröôøng khoâng ñieàu chænh ñöôïc vaø nhö ta ñaõ bieát, khoâng theå hieån thò tieáng
Vieät. Muoán boû teân tröôøng ôû truïc hoaønh ñi, choïn Graph > General Options, choïn
Display Status vaø taét choïn trong muïc Category Axis ôû phaàn Axes ñi.

Hình XV.10. Ñaët tieâu ñeà cho Bieåu ñoà.
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Keát quaû sau khi ñieàu chænh caùc thaønh phaàn khaùc nhau cuûa
bieåu ñoà coù theå troâng gioáng nhö treân hình XV.11.

Khi nhaép chuoät vaøo phaàn chuù giaûi (khoâng
nhaép vaøo phaàn chöõ hay phaàn oâ maøu chuù giaûi)
thì moät ñöôøng vieàn hieän leân vôùi caùc ñieåm
khoáng cheá hình vuoâng maøu ñen (hình
XV.11). Giöõ phím chuoät traùi treân caùc ñieåm
khoáng cheá naøy vaø reâ chuoät thì ta coù theå ñieàu
khieån chieàu roäng cuõng nhö chieàu cao cuûa
khung chuù giaûi cho phuø hôïp. Töông töï ta coù
theå ñieàu khieån chieàu roäng cuõng nhö chieàu cao cuûa khung bieåu ñoà cho phuø hôïp.

Ta cuõng coù theå ñieàu chænh khung cuûa chuù giaûi baèng caùch nhaép chuoät ñeå hieän
ñöôøng ranh giôùi cuûa khung chuù giaûi leân roài choïn Graph > Formatting ñeå ñieàu chænh
ñöôøng vieàn cuûa khung (töông töï böôùc 20 ôû treân) hay chænh maøu neàn trong phaàn Fill.

Treân bieåu ñoà khi nhaép chuoät leân choïn caùc giaù trò hieån thò treân ñaàu coät bieåu ñoà, teân
bieåu ñoà, tieâu ñeà phuï bieåu ñoà, teân truïc tung thì caùc ñöôøng vieàn xung quanh caùc chöõ ñoù
hieän ra. Ta coù theå giöõ phím chuoät traùi treân töø ñöôøng vieàn ñoù vaø di chuyeån chuùng ñeán
vò trí naøo ta muoán.

Khi di chuyeån chuoät ñeán meùp cuûa cöûa soå bieåu ñoà, con troû chuoät bình thöôøng bieán
thaønh hình muõi teân hai ñaàu vaø ta cuõng coù theå giöõ phím chuoät traùi vaø reâ chuoät ñeå ñieàu
chænh chieàu roäng cuõng nhö chieàu cao cuûa cöûa soå bieåu ñoà. Ñeå yù raèng khi ñieàu chænh
kích thöôùc cuûa cöûa soå bieåu ñoà, khung chuù giaûi vaø khung bieåu ñoà cuõng thay ñoåi theo.
Söï thay ñoåi cuõng xaûy ra ñoái vôùi kích thöôùc chöõ vaø trong nhieàu tröôøng hôïp laø thay ñoåi
tyû leä caùc thaønh phaàn cuûa bieåu ñoà khoâng theo yù muoán, vì theá ta neân choïn cho cöûa soå
Bieåu ñoà moät kích thöôùc nhaát ñònh ngay töø ñaàu roài môùi ñieàu chænh noäi dung beân trong.

Hình XV.11. Bieåu ñoà sau khi ñieàu chænh kieåu chöõ vaø khung bieåu ñoà.
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XV.2.2. Taïo bieåu ñoà quaït

Giöõ nguyeân “hieän traïng” cuûa phaàn bieåu ñoà môùi taïo xong, ta seõ taïo theâm moät bieåu
ñoà quaït cuõng töø daân soá cuûa 10 tænh treân.

- Thöïc hieän töông töï nhö trong phaàn XV.2.1 ôû treân nhöng baét ñaàu töø böôùc 4.

- Trong böôùc 5 thay vì choïn Column ta choïn kieåu Pie (kieåu hình quaït) vaø beân phaàn
Template cuõng choïn Pie.

- Thöïc hieän tieáp tuïc gioáng böôùc 6 ñeán böôùc 7 cuûa phaàn treân. Keát quaû laø bieàu ñoà hình
quaït ñöôïc taïo thaønh.

- Tieán haønh ñieàu chænh caùc phaàn tieâu ñeà cuõng nhö chuù giaûi töông töï nhö phaàn treân.
Keát quaû laø hình XV.12. Löu yù raèng vì ta taïo bieåu ñoà quaït töø cuøng soá lieäu cuûa 10 tænh
ñaõ ñöôïc söû duïng ñeå taïo bieåu ñoà coät neân ñeå phaân bieät teân cöûa soå bieåu ñoà quaït ñöôïc
ñaùnh theâm soá thöù töï laø soá 2 (_10_tinh_phia_Nam Graph: 2).

Trong phaàn bieåu ñoà hình quaït naøy coù moät soá tuyø choïn khaùc vôùi bieåu ñoà coät. Ta seõ
xem xeùt moät soá ñieåm chính cuûa bieåu ñoà naøy.

Kích hoaït cöûa soå bieåu ñoà quaït môùi taïo xong. Töø menu chính choïn Graph > General
Options ñeå môû hoäp thoaïi naøy ra. Trong muïc General ta coù caùc thanh tröôït:

- Pie Tilt: ñieàu chænh bieåu ñoà quaït quay leân xuoáng theo chieàu ngang.

- Pie Depth: ñieàu chænh chieàu daøy cuûa bieåu ñoà quaït.

- Pie Rotation: quay bieåu ñoà quaït xung quanh taâm cuûa bieåu ñoà.

- Explode Pie: “noå” caùc muùi cuûa hình quaït taùch xa nhau ra hay gaàn nhau laïi (hình
XV.13).

Haõy ñieàu chænh caùc thanh tröôït ñeå thaáy ñöôïc söï thay ñoåi cuûa bieåu ñoà maãu beân traùi.

Muïc Layout coù hai tuyø choïn laø Pie vaø Ring Pie. Tuyø choïn Ring Pie veõ bieåu ñoà daïng
hình vaønh khuyeân. ÔÛ döôùi laø tuyø choïn 2D Circular Pie. Neáu ñaùnh daáu vaøo tuyø choïn naøy
thì bieåu ñoà quaït taïo thaønh seõ laø moät hình troøn phaúng hai chieàu.

Trong muïc Data Labels ta coù tuyø
choïn Show Values maëc ñònh ñöôïc baät
leân. Döôùi tuyø choïn naøy ta coù tuyø choïn
Show Values as Percentage cho pheùp
hieån thò giaù trò theo tyû leä phaàn traêm bôûi
vì bieåu ñoà quaït thöôøng ñöôïc söû duïng
ñeå minh hoïa soá lieäu theo toång, toaøn
boä hình troøn laø 100%. Trong phaàn
Show Values naøy phía döôùi coù hai tuyø
choïn nöõa laø Values on Slices (hieån thò
soá lieäu ngay treân hình quaït) vaø Values
outside Slices (hieån thò soá lieäu beân
ngoaøi hình quaït). Ñaùnh daáu choïn vaøo
phaàn Show Labels seõ hieån thò nhaõn
(töùc teân caùc tænh trong ví duï naøy) treân
bieåu ñoà quaït. Phaàn Show Labels naøy
cuõng coù hai tuyø choïn con khaùc ñeå

Hình XV.12. Bieåu ñoà hình quaït daân soá 10
tænh phía Nam.
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hieån thò nhaõn trong bieåu ñoà quaït
(Labels on Slices) vaø ngoaøi bieåu ñoà
quaït (Labels outside Slices). Döôùi
cuøng laø tuyø choïn Show Leader
Lines, ñaùnh daáu vaøo noù seõ coù moät
ñöôøng chæ chaïy töø caùc hình neâm
cuûa bieåu ñoà quaït ra nhaõn hay ra giaù
trò cuûa hình neâm ñoù.

Ta cuõng coù theå laøm noåi baät moät
baûn ghi naøo ñoù baèng caùch ñieàu
chænh cho noù taùch ra xa hôn. Caùch
laøm: duøng coâng cuï choïn ñeà nhaép
chuoät leân choïn hình quaït caàn laøm
noåi baät, töø menu chính choïn Graph
> Series Options. Hoäp thoaïi Series
Options môû ra. Trong phaàn General
ta ñieàu chænh thanh tröôït Detach
Slice ñeå laøm cho hình neâm ñöôïc
choïn taùch ra xa hôn hay vaøo gaàn
hôn so vôùi hình quaït chung ñeå laøm
noù noåi baät leân. Caùc muïc Data
Labels vaø Numbers cho pheùp ñieàu
chænh nhaõn vaø ñònh daïng soá cho
rieâng hình neâm ñoù.

Leänh Series Options dó nhieân
cuõng coù theå ñöôïc söû duïng cho caùc
loaïi bieåu ñoà khaùc nhaèm muïc ñònh
laøm noåi baät moät hay vaøi thaønh phaàn
cuûa bieåu ñoà.

XV.2.3. Taïo bieåu ñoà baèng bieåu
thöùc

Trong hai ví duï treân chuùng ta
ñeàu taïo bieåu ñoà töø soá lieäu cuûa moät
tröôøng coù saün trong baûng cac_tinh
laø tröôøng dan_so. Trong ví duï naøy
chuùng ta seõ thöïc hieän moät ví duï ñôn giaûn cuûa vieäc taïo bieåu ñoà baèng bieåu thöùc.

Trong ví duï naøy ta seõ taïo bieåu ñoà maät ñoä daân soá cuûa 10 tænh treân theo bieåu thöùc
tính maät ñoä daân soá töø hai tröôøng dan_so vaø dien_tich.

- Thöïc hieän laïi töø böôùc 1 ñeán böôùc 3 trong phaàn XV.2.1 ñeå taïo laïi cöûa soå Browser cuûa
10 tænh treân.

- Töø menu chính choïn Window > New Graph Window. Hoäp thoaïi Create Graph - Step
1 of 2 môû ra.

- Giaû söû ta taïo bieåu ñoà hình que neân trong phaàn Graph ta seõ choïn Bar vaø trong phaàn
Template ta choïn Clustered.

Hình XV.13. Bieåu ñoà hình quaït daïng
“noå” caùc muùi ra.

Hình XV.14. Bieåu ñoà quaït daïng “noå”
moät soá muùi ra ñeå laøm noåi baät
chuùng leân.
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- Choïn Next. Hoäp thoaïi Create Graph - Step 2 of 2 môû ra.

- Trong oâ Table choïn _10_tinh_phia_Nam.

- Trong phaàn Fields from Table ta choïn Expression. Hoäp thoaïi Expression môû ra.

Ta bieát raèng maät ñoä daân soá
baèng soá daân chia cho dieän
tích. ÔÛ ñaây trong döõ lieäu cuûa
ta soá daân tính baèng nghìn
ngöôøi cho neân muoán tính maät
ñoä ñuùng ta phaûi nhaân trò soá
trong tröôøng dan_so vôùi 1000
tröôùc khi chia cho dieän tích.

- Nhaép chuoät vaøo nuùt thaû
xuoáng trong oâ Column beân
phaûi vaø choïn tröôøng dan_so.
Teân tröôøng naøy xuaát hieän
trong hoäp Type a numeric
Expression.

- Nhaép chuoät vaøo nuùt thaû
xuoáng trong oâ Operator vaø
choïn daáu nhaân (töùc daáu hoa
thò). Daáu naøy xuaát hieän caïnh
tröôøng dan_so trong oâ Bieåu
thöùc.

- Goõ 1000 vaøo sau daáu hoa thò
(nhaân tröôøng dan_so vôùi
1000 ñeå ñoåi veà soá daân thöïc
söï).

- Laïi choïn oâ Operator vaø choïn
daáu chia (daáu xuyeäc xuoâi).

- Choïn oâ Column vaø choïn tröôøng dien_tich.

Löu yù raèng vieäc choïn tröôøng, toaùn töû vaø haøm soá töø caùc oâ Column, Operator vaø
Function nhaèm giuùp cho vieäc laäp bieåu thöùc deã daøng hôn maø thoâi. Khi thaønh thaïo ta
coù theå khoâng caàn söû duïng ñeán caùc oâ naøy maø coù theå goõ tröïc tieáp bieåu thöùc vaøo oâ
Type a numeric Expression.

Keát quaû cuoái cuøng laø bieåu thöùc coù daïng:

dan_so*1000/dien_tich

Trong tröôøng hôïp naøy, giaû söû neáu khoâng coù coät dieän tích, ta coù theå goïi haøm soá tính
dieän tích ngay trong bieåu thöùc naøy ñeå laáy dieän tích töø baûn ñoà (dó nhieân vôùi ñieàu kieän
baûn ñoà phaûi ñöôïc soá hoaù chính xaùc) ñeå laäp coâng thöùc tính maät ñoä. Khi ñoù bieåu
thöùc ta phaûi goõ vaøo seõ laø:

dan_so*1000/Area(obj,”sq km”)

(Area (obj,”sq km”) laø haøm soá tính dieän tích theo km vuoâng)

Hình XV.14. Laäp bieåu ñoà baèng bieåu thöùc -
döõ lieäu ñeå laäp bieåu ñoà ñöôïc laáy töø caùc
tröôøng khaùc nhau.
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- Choïn OK ñeå ñoùng hoäp thoaïi Expression vaø quay laïi hoäp thoaïi Create Graph - Step
2 of 2. Bieåu thöùc naøy ñöôïc naïp vaøo oâ Fields for Graph.

- Trong oâ Label with Column choïn tröôøng ten. Ñaùnh daáu vaøo tuyø choïn Series in Rows.

- Choïn OK ñeå keát thuùc.

Keát quaû ta coù bieåu ñoà maät ñoä daân soá 10 tænh phía Nam.

- Tieán haønh chænh caùc thaønh phaàn cuûa bieåu ñoà nhö trong phaàn XV.2.1 ôû treân. Löu yù
raèng trong phaàn Graph > Titles, ôû muïc Value Title (Y1) ta goõ vaøo tieâu ñeà cuûa truïc
tung laø “Maät ñoä (ngöôøi/km2)” ñeå ngöôøi xem bieát ñôn vò tính maät ñoä laø ngöôøi/km2. Keát
quaû cuoái cuøng coù theå troâng gioáng nhö treân hình XV.14.

XV.3. CAÙC KIEÅU BIEÅU ÑOÀ

Caùc phaàn treân chæ ñeà caäp ñeán hai loaïi bieåu ñoà laø bieåu ñoà coät vaø bieåu ñoà hình quaït.
Thöïc ra trong MapInfo coù taát caû 10 kieåu bieåu ñoà khaùc nhau. Moãi kieåu bieåu ñoà laïi coù ít
nhaát moät maãu maø ta coù theå choïn ñeå taïo bieåu ñoà. Phaàn döôùi ñaây giaûi thích sô boä caùc
kieåu bieåu ñoà trong MapInfo.

XV.3..1. 3D Graphs (Bieåu ñoà 3 chieàu)

Tuyø choïn naøy cho pheùp ta taïo moät soá kieåu bieåu ñoà 3 chieàu. Haàu heát caùc maãu cuûa
bieåu ñoà 3D ñeàu laø caùc daïng bieán theå cuûa bieåu ñoà coät. Khi ñaõ choïn moät kieåu maãu roài
thì seõ coù nhieàu thieát laäp ñeå ñieàu chænh hình daïng cuûa bieåu ñoà, ñaëc bieät laø ñaëc ñieåm goùc
nhìn. Loaïi bieåu ñoà naøy coù caùc kieåu maãu sau:

- 3D Bar: laø daïng bieåu ñoà coät chuaån coù hình daïng 3 chieàu.

- 3D Floating Cube: moãi giaù trò ñöôïc ño löôøng vaø ñöôïc hieån thò thaønh moät hình khoái.
Giaù trò döõ lieäu seõ quy ñònh vò trí cuûa hình khoái trong bieåu ñoà. Nhöõng hình khoái coù giaù
trò cao hôn dó nhieân laø seõ “noåi” cao hôn trong bieåu ñoà.

- 3D Floating Sphere: töông töï nhö kieåu 3D Floating Cube, ngoaïi tröø giaù trò döõ lieäu
ñöôïc bieåu thò thaønh moät hình caàu.

- 3D Line: caùc giaù trò döõ lieäu ñöôïc söû duïng theo moät nhoùm (tröôøng), ví duï nhö moät
quoác gia hay moät thaønh phoá vaø ñöôïc hieån thò thaønh moät ñöôøng lieân tuïc chaïy ngang
qua truïc toaï ñoä bieåu ñoà. Ñöôøng bieåu dieãn chaïy xuoáng hay leân tuøy theo giaù trò döõ
lieäu.

- 3D Pyramid: Moãi giaù trò döõ lieäu ñöôïc bieåu dieãn thaønh moät hình kim töï thaùp 3 chieàu.
Bieåu ñoà kieåu naøy döïa treân bieåu ñoà coät; giaù trò caøng lôùn thì hình kim töï thaùp caøng cao.

- 3D Round: Bieåu ñoà kieåu naøy gioáng nhö kieåu 3D Bar Graph, ngoaïi tröø caùc döõ lieäu
ñöôïc hieån thò thaønh hình truï troøn thay vì hình que.

XV.3.2. Area Graphs (Bieåu ñoà daïng dieän tích)

Bieåu ñoà daïng dieän tích bieåu thò chuoãi bieåu ñoà thaønh moät vuøng, trong ñoù vuøng dieän
tích tính töø truïc hoaønh leân ñeán ñöôøng ñoà thò cuûa chuoãi döõ lieäu ñöôïc toâ maøu. Loaïi naøy
goàm coù caùc kieåu maãu sau:

- Clustered (Goäp nhoùm): Moät bieåu ñoà dieän tích kieåu goäp nhoùm veõ caùc giaù trò döõ lieäu
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chung vôùi nhau ñeå bieåu dieãn moái töông quan tuyeät ñoái giöõa caùc chuoãi döõ lieäu.

- Percent (Phaàn traêm): bieåu ñoà dieän tích kieåu tyû leä phaàn traêm laø moät daïng kieåu vuøng
cuûa bieåu ñoà hình quaït. Moãi nhoùm seõ ñöôïc MapInfo tính giaù trò phaàn traêm treân toång
cuûa chuoãi döõ lieäu ñoù. Truïc trung chaïy töø 0 ñeán 100%.

- Stacked (Daïng coäng doàn): caùc giaù trò döõ lieäu kieåu dieän tích ñöôïc choàng caùi naøy leân
caùi kia. Giaù trò theo truïc tung laø toång tích luyõ cuûa taát caû caùc nhoùm.

XV.3.3. Bar Graphs (Bieåu ñoà hình que)

Goàm coù caùc maãu:

- Clustered: Bieåu ñoà hình que theo nhoùm laø moät daïng taäp hôïp caùc coät hình que naèm
caïnh nhau. Ñaây laø daïng bieåu ñoà hai chieàu chuaån.

- Percent: Bieåu ñoà hình que theo tyû leä phaàn traêm laø söï bieåu dieãn theo kieåu hình que
cuûa moät bieåu ñoà daïng hình quaït. Moãi moät nhoùm ñöôïc MapInfo tính giaù trò phaàn traêm
döïa treân toång cuûa töøng chuoãi. Truïc tung coù giaù trò töø 0 ñeán 100%.

- Stacked: Bieåu ñoà hình que daïng coäng doàn bieåu dieãn nhoùm giaù trò caùc coät coäng doàn
vôùi nhau. Moãi “choàng” bao goàm taát caû chuoãi trong moät nhoùm, ñöôïc xeáp choàng leân
nhau ñeå ra toång chung. Truïc döõ lieäu laø toång giaù trò cuûa caùc haøng ñöôïc coäng doàn laïi.

XV.3.4. Bubble Graph (Bieåu ñoà daïng Bong boùng)

Bieåu ñoà daïng bong boùng cho pheùp ta veõ caùc giaù trò theo truïc X - Y ñoàng thôøi so
saùnh giaù trò thöù ba laø Z döïa vaøo kích thöôùc hieån thò trong bieåu ñoà. Bieåu ñoà daïng bong
boùng caàn coù 3 giaù trò cho moät baûn ghi laø X, Y vaø Z theo ñuùng thöù töï.

XV.3.5. Column Graphs (Bieåu ñoà coät)

Daïng bieåu ñoà naøy bao goàm caùc maãu:

- Clustered: moãi nhoùm coät trong cuøng moät loaïi döõ lieäu ñöôïc xeáp nhoùm chung vôùi nhau.

- Percent: laø daïng khaùc cuûa bieåu ñoà quaït. Moãi nhoùm döõ lieäu ñöôïc MapInfo tính tyû leä
phaàn traêm döïa teân toång cuûa töøng chuoãi.

- Stacked: bieåu ñoà coät daïng coäng doàn hieån thò caùc nhoùm coät döõ lieäu ñöôïc coäng doàn
laïi vôùi nhau. Moãi moät coät coäng doàn (Stack) ñöôïc taïo thaønh töø moät chuoãi trong nhoùm,
taïo thaønh toång. Truïc toaï ñoä coù giaù trò laø toång tích luyõ cuûa caùc giaù trò döõ lieäu.

XV.3..6. Histogram Graph (Bieåu ñoà taàn soá)

Caùc bieåu ñoà Histogram bieåu thò söï phaân boá taàn soá. Kieåu bieåu ñoà naøy goäp nhoùm caùc
giaù trò döõ lieäu thaønh caùc khoaûng giôùi haïn döïa vaøo döõ lieäu. Noù xeáp moät soá löôïng döõ lieäu
naøo ñoù vaøo moät khoaûng giôùi haïn. Caùc khoaûng giôùi haïn ñöôïc trình baøy ôû daïng hình que.
Coù hai kieåu maãu laø:

- Horizontal: caùc hình que ñöôïc saép naèm ngang.

- Vertical: Caùc hình que ñöôïc xeáp thaúng ñöùng.
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XV.3.7. Line Graph (Bieåu ñoà daïng ñoà thò ñöôøng)

Goàm coù caùc maãu sau:

- Clustered: Trong moät bieåu ñoà kieåu ñöôøng daïng goäp nhoùm, caùc ñöôøng ñöôïc veõ chung
vôùi nhau ñeå cho thaáy moái lieân heä tuyeät ñoái giöõa caùc chuoãi döõ lieäu.

- Percent: Bieåu ñoà ñöôøng kieåu phaàn traêm laø daïng minh hoaï theo kieåu ñöôøng cuûa moät
bieåu ñoà hình quaït. Moãi nhoùm ñöôïc tính giaù trò phaàn traêm cuûa noù so vôùi toång cuûa töøng
chuoãi döõ lieäu. Truïc toaï ñoä coù giaù trò töø 0 ñeán 100%.

- Stacked: trong moät bieåu ñoà ñöôøng daïng coäng doàn, caùc ñöôøng ñöôïc xeáp choàng leân
nhau. Truïc toaï ñoä coù giaù trò laø toång tích luyõ cuûa taát caû caùc nhoùm.

XV.3.8. Pie Graph (Bieåu ñoà hình quaït)

Coù hai daïng:

- Pie: Bieåu ñoà hình quaït bieåu thò phaàn traêm cuûa döõ lieäu ôû daïng hình reû quaït so vôùi
toång.

- Ring Pie: laø moät daïng bieán theå cuûa bieåu ñoà hình quaït. Noù troâng gioáng nhö moät hình
vaønh khuyeân hay daïng “caùi baùnh voøng”. Toång cuûa taát caû caùc “mieáng” döõ lieäu ñöôïc
ñaët ngay chính giöõa.

XV.3.9. Scatter Graph (Bieåu ñoà phaân taùn)

Bieåu ñoà phaân taùn laø moät daïng ñoà thò chuaån theo truïc X-Y. Noù caàn coù hai döõ lieäu
cho moät ñieåm chaám treân ñoà thò, X vaø Y, theo ñuùng thöù töï ñoù.

XV.3.10. Surface Graph (Bieåu ñoà daïng taám)

Goàm coù caùc kieàu:

- Surface: loaïi naøy trình baøy taát caû caùc ñieåm döõ lieäu thaønh moät beà maët, gioáng nhö maët
soùng.

- Surface with Sides: laø moät daïng bieán theå cuûa loaïi Surface, trong ñoù caùc beà maët cuûa
bieåu ñoà laø caùc maët ñaëc (solid side).

- Surface, Honeycombed: cuõng laø moät daïng bieán theå cuûa bieåu ñoà daïng taám, trong ñoù
caùc maët cuûa bieåu ñoà troâng gioáng nhö daïng toå ong.
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